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A Computer is an electronic device that performs calculations and operations based on 
instructions provided by a software or hardware program. 

 

1.​ Speed – A computer can process millions of calculations per second. The speed 
of computation is very high. 

2.​ Accuracy - As computers work on inbuilt software programs, there is no scope 
for human errors and highly accurate. 

3.​ Diligence – Computers are highly reliable. They can perform complex and long 
calculations with the same speed and accuracy. 

4.​ Versatility - Computers are versatile in Nature. They can perform various 
operations at the same time. 

5.​ Storage - Computers can store a large amount of data or instructions in its 
memory which can be retrieved at any point of time. 

 

A Computer was intended for making a person capable of performing numerical 
calculations with the help of a mechanical computing device. 

Abacus 

Abacus was the first counting device which was developed in China. It consists of a 
rectangular wooden frame and beads. The wooden frame contains horizontal rods 
and the beads which are passed through the rods. The beads of counters represent 
digits. The device is used to perform simple addition and subtraction. 

Napier’s Bones 

It was a device which contained a set of rods made of bones. It was developed by a 
Scottish Mathematician, John Napier. To perform multiplication and division, the 
device was developed. Napier also invented logarithms. 

Pascaline 

Pascaline was the first calculating device with a capability to perform additions and 
subtractions on whole numbers. It was developed by Blaise Pascal, a French 
Mathematician.​ The device made up of interlocked cog wheels having numbers 0 to 9 
on its circumference. When one wheel completes its rotation, the other wheel moves 
by one segment. 

Punched Card System 

Punched Card System was invented by Herman Hollerith, an American Statistician. It 
was used for storing and retrieving data. In the form of punched holes, the system 
data could be stored. 

 



 

 
Charles Babbage’s Calculating Engines (1792-1871) 

Babbage invented the Difference Engine to solve algebraic 
expressions and mathematical tasks accurately. Later, he 
designed some improvements to his first computer. The 
modified machine is called the Analytical Engine. He 
intended to design a machine with a collection of the four 
basic arithmetic functions. The design principle of the 
Analytical Engine can be divided into Input, Output, 
Memory, Central Processing Unit. The parts and working 
principle of an Analytical engine are the same as today’s 
computer. Hence, Charles Babbage is known as the Father 
of Computer. 

Hollerith Machine 

A Hollerith machine was incorporated with the tabular and 
punched cards. The machine could census the punched 
holes, recognise the number and make the required 
calculation and store the data of census. The machine was 
invented by Herman Hollerith. 

Mark I Computer 

The first electro-mechanical computing device was 
developed by Howard Hathaway Aiken. He used Hollerith’s 
punch card and Babbage’s statements to develop Mark I 
computer with IBM. In Mark III computer, he used some 
electronic components and Magnetic drum memory. In 
Mark IV computer, he used all electronic components and 
Magnetic drum memory & Magnetic core memory. 

First Un-programmable Electronic Digital Computer (ABC) 

The Atanasoff-Berry Computer (ABC) was the first 
electronic computer. It was designed by John Vincent 
Atanasoff and Clifford E. Berry. It was designed to solve 
systems of linear algebraic equations. It was also the first 
to use capacitors for storage. 

Electronic Numerical Integrator and Calculator – ENIAC 

ENIAC was the first electronic computer used for general 
purposes, such as solving numerical problems. It was 
invented by J. Presper Eckert and John Mauchly. 

Electronic Discrete Variable Automatic Computer – EDVAC 

EDVAC was the successor of ENIAC. In this computer, 

 



 

Binary numbers were used for arithmetic operations and 
the internal storage of instructions were also written in 
digital forms. 

Electronic Delay Storage Automatic Calculator – EDSAC 

EDSAC was the first practical general-purpose 
stored-program electronic computer. It was built according 
to the von Neumann machine principles. 

Universal Automatic Computer - UNIVAC 

UNIVAC was the first commercially available computer. It 
was made by the Eckert- Mauchly Computer Company. It 
represents the birth of the modern computers. 

 



 

 
Micro Processor – INTEL 4004 

In 1969, Intel Corporation designed the first general-purpose programmable processor 
INTEL 4004. It was a set of four chips known as the MCS-4. It included a central 
processing unit chip (the 4004) as well as a supporting read-only memory chip for the 
custom applications programs, a random-access memory (RAM) chip for processing 
data, and a shift-register chip for the input/output (I/O) port. 

Quick Revision 
 

Particulars Name of Person/System 

Father of Computer Charles Babbage 

Father of Modern Computer Science Alan Tuning 

First Non-programmable Electronic 
Digital Computer 

Atanasoff Berry Computer (ABC) 

First General Purpose Electronic Digital 
Computer 

Electronic Numerical Integrator and 
Calculator (ENIAC) 

First Micro Processor INTEL 4004 

First Commercially Available Computer Universal Automatic Computer 
 

First Generation Computers– (1946-1959) 

The first-generation computers were used vacuum tubes as the electronic 
components. They occupied a very large space and performed computations in 
milliseconds. Machine languages are used. 

Examples – EDSAC, EDVAC, UNIVAC, IBM-701, IBM-650. 

Second Generation Computers – (1959-1965) 

The second-generation computers replaced Vacuum Tubes with Transistors. They used 
assembly languages and batch processing operating system. Magnetic cores and 
magnetic tapes were used as storage. 

Examples – IBM-1620, IBM -7094, CDC-1604, CDC-3600. 

 



 

 
Third Generation Computers – (1965-1971) 

The third-generation computers replaced transistors with integrated circuits (ICs). 
They performed computation in Nanoseconds. It used high-level languages like 
FORTRAN, COBOL, PASCAL, ALGO-68, BASIC was used. In this generation, remote 
processing, time-sharing, multi-programming operating system were used. 

Examples - IBM-360 series, Honeywell-6000 series, PDP, IBM-370/168. 

Fourth Generation Computers – (1971-1980) 

The fourth-generation computers are used Very Large Scale Integrated (VLSI) circuits. 
Semi-conductor devices are used as primary memory. Magnetic disks are used as 
secondary storage. Problem-oriented fourth generation languages (4GL) are used. 
Multi-processing and multiprogramming operating systems are used. 

Example – Apple series – I & II, IBM 4341, DEC 10, STAR 1000, PUP 11. 

Fifth Generation Computers – (1980 - Present) 

The fifth-generation computers use ultra large scale integrated (ULSI) chips that 
contain millions of components on a single chip. They are in the developmental 
stage which is based on the artificial intelligence. These computers can also respond 
to natural language input. Biochips will be used as memory devices and KIPS 
(Knowledge-based Information Processing System) architecture will be used. 

Examples – Robots, Supercomputers. 
 

 
Based on Operation 

�​ Analog Computer - An Analog computer stores data continuously in the form 
of physical quantities and perform calculations with the help of measures. It 
produces output in the form of a graph. They are used in the calculation of 
physical variables such as voltage, pressure, temperature, speed, etc. 

�​ Digital Computer - A Digital computer is the most commonly used type of 
computer and is working with data represented in digital form, usually binary 
0s and 1s. It can perform faster and give more accurate results. They are 
extensively used for solving complex problems in the field of engineering & 
technology, design, research and data processing. 

 
�​ Hybrid Computer – A Hybrid computer is a combined feature of Analog and 

Digital computers. In large industries and businesses, a hybrid computer can 
be used for logical operations as well as efficient processing of differential 
equations. 

 



 

Based on Configuration 

�​ Micro Computer – Microcomputers are small, inexpensive computer for personal 
use. They are popularly used at homes for playing games and surfing the 
Internet. 

�​ Mini Computer - Minicomputers possess most of the features and capabilities of 
a large computer but are smaller in physical size. They are used as small or mid- 
range operating business and scientific applications. 

�​ Mainframe Computer – Mainframe computers are expensive and large size 
computers and they are capable of supporting hundreds of users simultaneously. 
They are used for specific large-scale applications. 

�​ Super Computer - Supercomputers are powerful, expensive and the fastest 
computers. They have architectural and operational principles from parallel and 
grid processing for performing billions and trillions of calculations per second. 
They are used for applications that require large amounts of mathematical 
computations like weather forecasting, fluid dynamics, graphic design etc. 
India launched ‘Mihir’ supercomputer recently to improve India’s weather 
forecasting. 

 
Particulars Name of the Computer 

First Super Computer in the world 
Cray CDC 6600 

Fastest Super Computer in the world 
Summit by the USA 

First Super Computer of India 
PARAM 8000 

Fastest Super Computer in India 
Pratyush 

 
Based on Utility 

 
�​ General Purpose Computer - A general purpose computer can perform an 

extensive variety of operations. It can store and execute different programs in 
its internal storage. All mainframes, servers, laptop and desktop computers, 
smartphones and tablets are general-purpose devices. 

�​ Special Purpose Computer - Special purpose computers are designed to solve 
specific problems. The instructions are pre-programmed permanently in the 
computer. It completely controlled by automated manufacturing processes. 
Example – Aircraft control system, Electronic voting machines etc. 

 



 

 
Based on Mode of Use 

�​ Palmtop Computer – Palmtop computers are small which can fit in the palm of a 
hand. The electronic pen is used to give an input. They have small disk storage 
and can be connected to a wireless network. 

�​ Laptop Computer – Laptop computers are portable with less weight. It can be 
transported easily and used in temporary space such as Airplane, Meetings etc. 
They are designed for low power consumption and have an attached keyboard 
and a touchpad. 

 
�​ Personal Computer (PC) - A personal computer is a cost-effective computer that 

is designed for a single end-user. PC is dependent on microprocessor 
technology, which allows PC makers to set the entire central processing unit 
(CPU) on a single chip. 

�​ Workstation - Workstation (WS) is faster than Personal Computer. It is designed 
for a user or group of users with better multitasking capability, additional 
Random-Access Memory, Higher-speed graphics adapters and drive capacity. 

�​ Client and Server – The server is a device that manages the sharing of network 
resources to the users. An Application server, File server, Virtual server, Mail 
server are some types of server. A client is the receiving end of the service 
which made by the server. It requests the server and gains access with the 
server. 

 
A computer system has four basic components. 
Parts of a computer system 

�​ Hardware - It represents the physical and tangible components of the computer 
(keyboard, mouse, monitor etc.) 

 
�​ Software – It is a set of electronic instructions called programs that make the 

computer perform tasks. 

�​ Data – It is a set of facts, which the computer stores and reads in the form of 
numbers. 

 
�​ Users - Users are the people who make use of a computer to obtain 

certain results/ outcomes. 
 

Mother Board – It is the main printed circuit board of a computer that carries the 
central processing unit (CPU) chip, Read Only Memory (ROM), Random Access Memory 
(RAM) and the basic input output system (BIOS) chip. 

 



 

 

 

The Basic Diagram of the Computer consists of Input Unit, Output Unit and Central 
Processing Unit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Input Unit 
The input unit is used for giving instructions and data by using input devices. It 
converts these instructions and data to the computer acceptable format and it supplies 
the converted instructions and data to the computer system for further processing. 

Central Processing Unit 
The central processing unit (CPU) performs most of the processing inside a computer. 
CPUs have been constructed on a single integrated circuit called a microprocessor. It 
consists of the control unit, the Arithmetic Logic Unit (ALU), and the memory unit. 

(1)​ Control Unit 
The control unit manages the computer's various components. It reads and 
interprets (decodes) the program instructions, transforming them into control 
signals that activate other parts of the computer. 

 
(2)​ Arithmetic Logic Unit 

The ALU can perform arithmetic and logical operations. The set of arithmetic 
operations that an ALU supports to addition, subtraction and more complex 
mathematical operations. Logic operations involve Boolean logic like AND, OR, 
XOR, and NOT. These can be useful for creating complicated conditional 
statements. 

 
(3)​ Memory Unit 

 



 

Computer main memory consists of primary and secondary memory. 

 



 

 

 

Primary memory holds only those data and instructions on which computer is currently 
working. It has limited capacity and data is lost when power is switched off. It is 
generally made up of the semiconductor device. It is a volatile memory. The two types 
of primary memory are Random Access Memory (RAM) & Read Only Memory (ROM). 

 
RAM (Random Access Memory) - RAM is the internal memory of the CPU for storing 
data, program and result of the program. It is read/write memory which stores data 
till the machine is working. Some types of RAMs are Dynamic RAM (DRAM), Static 
RAM (SRAM) and Synchronous Dynamic RAM (SDRAM), etc. 

Dynamic Random-Access Memory (DRAM) – Dynamic memory must be constantly 
refreshed, or it loses its contents. This type of memory is more economical. 

 
Static Random-Access Memory – SRAM is faster and less volatile than DRAM but 
requires more power and is more expensive. It does not need to be refreshed like a 
DRAM. 

 
Synchronous Dynamic Random-Access Memory - A type of DRAM that can run at much 
higher clock speeds. 

 
ROM (Read Only Memory) - ROM stores data permanently on personal computers 
(PCs) and other electronic devices. It performs major input/output tasks and holds 
programs or software instructions. It is non-volatile. 

 
MROM (Masked ROM) - The very first ROMs were hard-wired devices that contained a 
pre-programmed set of data or instructions. These kinds of ROMs are known as 
masked ROMs which are inexpensive. 

PROM (Programmable Read Only Memory) - PROM can be modified only once by a 
user. The user can buy a blank PROM and enter the desired contents using a PROM 
program. 

 
EPROM (Erasable and Programmable Read Only Memory) - The EPROM can be erased 
by exposing it to ultra-violet light. EPROMs have a Quartz window in the package to 
expose the chip to UV light. They were widely used as the BIOS (Basic Input Output 
System) chips in computer motherboards. 

 
EEPROM (Electrically Erasable and Programmable Read Only Memory) - The EEPROM is 
programmed and erased electrically. It can be erased and reprogrammed about ten 
thousand times. Both erasing and programming take about 4 to 10 milliseconds. They 
were also used as BIOS chips. 

 



 

 

 

Secondary memory stores data on a long-term basis. It cannot be processed directly 
by the CPU. It must first be copied into primary storage. Secondary memory devices 
include magnetic disks like hard drives and floppy disks, optical disks such as CDs and 
CDROMs, and magnetic tapes, USB Flash drives. 

 
Hard drive – It is a non-removable storage device containing magnetic disks or 
platters rotating at high speeds. The hard drives store data in segments of concentric 
circles. It may spin at 5,400 to 15,000 RPM. 

 
Floppy Disk - Floppy disk is composed of a thin, flexible magnetic disk sealed in a 
square plastic carrier. Floppy disks were widely used to distribute software, transfer 
files, and create backup copies of data. To read and write data from a floppy disk, a 
computer system must have a floppy disk drive (FDD). 

Compact Disc (CD) - A compact disc is a portable storage medium that can be used to 
record, store data in digital form. They are fragile and prone to scratches. 

 
Compact disc read-only memory (CD-ROM) - It is a storage device that can be read 
but can’t change or delete it. 

 
Digital Video Disc (DVD) - A device currently used to store data in large amounts and 
accepts high definition material. A two-layered DVD can hold approximately 17 
gigabytes of video, sound, or other data. 

 
Blue-ray Disc – The upgraded version of CD and DVD discs and drives are the Blu-ray 
discs. It is commonly known as BD-ROM. The Maximum capacity of BD disc is 25GB if 
single layer and 50 GB if dual layer. 

 
Holographic Versatile Disc (HVD) – It is a holographic storage format and has a 
maximum capacity of 3.9 terabytes. 

Flash Drives – Flash drives are small, ultra-portable storage device. They connect to 
computers and other devices via a built-in USB plug. They are often referred to as pen 
drives, thumb drives, or jump drives. Mostly they have a storage capacity from 8 GB 
to 64 GB. 

 
Zip Disks – An advanced version of the floppy disk is known as Zip Disks. It was 
developed by Iomega. Zip disks are available in 100 and 250-MB and 750 MB 
capacities and they are used to store, share and back up large amounts of data. 

 
Cache Memory - It is a very high-speed semiconductor memory which can speed up 
the CPU. It acts as a buffer between the CPU and main memory. Example: Registers 

Virtual Memory - Virtual memory permits software to use additional memory by 
utilizing the hard disk drive (HDD) as temporary storage. 

 



 

 
Quick Revision 

 

Types Examples 

Semiconductor Memory RAM, ROM 

Optical Memory CD-ROM, CD-R, DVD, HVD, Blu-ray Disc 

Magnetic Memory Hard Disk Drive (HDD), Floppy Disk Drive (FDD) 

Flash Memory Pen drive, Memory card etc (EEPROM Technology devices) 

Output Unit 
The output unit provides the information from the computer to an external device. It 
presents a soft/ hard copy of the information which can be readable by the users. 

 

A peripheral device links to a computer system to enhance the functionality of the 
computer. It is not part of the core computer architecture. Input devices, output 
devices, and storage devices are the types of peripheral devices. 

 

Input devices serve as a link between a user and the computer. It allows users to feed 
instructions and data to computers for processing, display, storage and/or 
transmission. Some input devices are: 

1.​ Keyboard – It is used to enter data into the computer in both alpha and numeric 
forms. 

Some important keys in a keyboard are: 

(i)​ Toggle Keys - It is used to change the input mode of a group of keys on a 
keyboard. Caps Lock, Num Lock, Scroll Lock are toggle keys. 

 
�​ Caps Lock – Capitalizes all letters. 

�​ Num Lock – Makes sure numbers are inputs from the keypad. 

�​ Scroll Lock - Allows the arrow keys to scroll through the contents of a window. 
(ii)​ Modifier Keys - It is a special key (key combination) that temporarily modifies 

the normal action of another key when pressed together. Shift, Alt, Ctrl, Fn are 
modifier keys. 

�​ Shift - used for capitalizing letters and entering different types of symbols. 

�​ Function (Fn) - Other functions such as brightness and volume control. 

 



 

�​ Control (Ctrl) - used for entering keyboard shortcuts, such as Ctrl+S, Ctrl+P etc. 
 

�​ Alt - used in combination with the numeric keys and the Control key for entering 
keyboard shortcuts. 

 



 

(iii)​ Function Keys - A key on a computer keyboard, distinct from the main 
alphanumeric keys, to which software can assign a function. F1 - F12 keys are 
known as function keys and each key performs a different function. It may be 
used as single key commands (e.g., F5) or combined with one or more modifier 
keys (e.g., Alt+F4). 

 
(iv)​ Escape Key – It is located in the upper left corner of a computer keyboard. It is 

often used to quit, cancel, or abort a process which is running on a computer. 
 

2.​ Mouse - It is a pointing and cursor-control device. A round ball at its base 
senses the movement of a mouse and sends corresponding signals to CPU 
when the mouse buttons are pressed. A mouse has two or three buttons called 
Left, Right, and Middle button. 

 
3.​ Joy Stick – It is used to move the cursor position on a monitor screen. It is 

mainly used in Computer Aided Design (CAD) and playing games on the 
computer. It can also be helpful as an input device for people with movement 
disabilities. 

4.​ Track Ball – It is mostly used in notebooks or laptops. It is a ball which is half 
inserted and by moving fingers on the ball, the pointer can be moved. 

 
5.​ Scanner – It captures images from printed material and converts it into a digital 

format that can be stored within the PC. Flatbed Scanners, Hand Scanners, 
Sheetfed Scanner are some types of scanner. 

6.​ Barcode Reader – It is an electronic device for reading printed barcodes. A light 
sensor in the barcode reader can read the barcode and translates optical 
impulses into electrical impulses to store the data into the computer. It is an 
important tool for warehouse management and operations. 

 
7.​ Magnetic Ink Character Recognition (MICR) – It is a character recognition 

system that uses special ink and characters. It is used to verify the legitimacy or 
originality of paper documents, especially cheques. Information can be encoded 
in the magnetic characters. It provides a secure, high-speed method of scanning 
and processing information 

8.​ Optical Character Recognition (OCR) - It is a technology that recognizes text 
within a digital image. It converts the document to an editable text file. 

 
9.​ Optical Mark Recognition (OMR) – It is an electronic method that scans the 

document and reads the data from the marked fields and results can be 
transmitted into the computer. 

10.​ Digitizer – It allows users to draw and manipulate graphics on the screen. It is 
also known as a graphics tablet. These kinds of tablets typically designed for 
CAD/CAM professionals. 

 



 

11.​ Touch Screen - It is a computer display screen that serves as an input device. A 
touchscreen can be touched by a finger or stylus. Touchscreen records the event 
and sends it to a controller for processing. 

 
12.​ Microphone – Microphone translates sound vibrations in the air into electronic 

signals. It enables many types of audio recording devices for purposes 
including communications, music and speech recording. 

 
13.​ Web Camera – It captures and stores images in digital form. The stored images 

can be can be archived on a photographic compact disc or external hard disk. 
 

14.​ Light Pen - It is a light-sensitive input device, used to select text, draw pictures 
and interact with user interface elements on a computer screen or monitor. 

 

The Output devices are used to send data from a computer to another device. 
Examples are monitors, projectors, speakers, plotters, and printers etc. 

1.​ Monitors – Monitors are the main output device of a computer. It forms images 
from tiny dots that are arranged in a rectangular form. The sharpness of the 
image depends on the number of pixels. There are two kinds of viewing screens 
used for monitors. 

 
(i)​ Cathode-Ray Tube (CRT) - The CRT display is made up of small picture elements 

called pixels. CRT tube creates an image on the screen using a beam of 
electrons. 

 
(ii)​ Flat- Panel Display - The flat-panel display refers to a class of video devices that 

have reduced volume, weight and power requirement in comparison to the CRT. 

(iii)​ Liquid Crystal Display (LCD) Monitor - LCD monitors use compact fluorescent 
tubes to illuminate and brighten the image on the screen and produce good 
image quality, resolution and contrast levels. 

 
(iv)​ Light Emitting Diode (LED) Monitor - LED monitors use new backlighting 

technology to improve picture quality. The LED monitor is more lifelike and 
accurate due to the improved contrast ratios and colour saturation over LCD. 

(v)​ Organic Light Emitting Diode (OLED) Monitor – This type of monitor made up of 
some organic material (containing carbon, like wood, plastic or polymers) that is 
used to convert the electric current into light. They are directly used to produce 
the correct colour and there is no need for backlight which saves power and 
space. 

 



 

2.​ Printers – Printers are output devices that prints information in the form of 
text/images on a paper. Impact Printers and Non-impact printers are the two 
types of printers. 

 
(i)​ ​ The impact printers print the characters by striking them on 

the ribbon which is then pressed on the paper. Examples: Dot-Matrix Printers, 
Line Printers, Daisy wheel printer, Drum printer, Chain printer, Band printer. 

 
Dot-Matrix Printers – It prints characters as a combination of dots. They have a matrix 
of pins on the print head of the printer which form the character. They generally have 
9-24 pins. Their speed is measured in cps (Character per second). 

 
Line Printers - A line printer is an impact printer which can print one line of text at a 
time. It is also known as a bar printer. 

(ii)​ Non-Impact Printers - Non-impact printers print the characters on the paper 
without using ribbon. These printers print a complete page at a time, so they are 
also called as page printers. Examples - Laser Printers, Inkjet Printers etc. 

Laser Printers - A laser printer is a popular type of personal computer printer that uses 
a non-impact photocopier technology. The type of ink used in a laser printer is dry. It 
gives high-quality output. The resolution of laser printers is measured in dpi (dots-per- 
inch). 

 
Inkjet Printers - Inkjet printers work by spraying ink on a sheet of paper. The type of 
ink used in an inkjet printer is wet. 

 
(iii)​ Other Types 

 
Solid Ink Printer - It is a type of colour printer. It works by melting the solid ink that 
applies the images to the paper. It is non-toxic and convenient to handle. 

LED Printer - This type of printer uses a light emitting diode instead of a laser. It starts 
by creating a line-by-line image of the page. 

 
3.​ Plotters - A plotter is an output device used to produce hard copies of large 

graphs and designs on paper, such as construction drawings, architectural plans, 
and business charts. Drum plotters and Flatbed plotters are the types of 
plotters. 

 
(i)​ Drum plotter – It is a pen plotter that wraps the paper around a drum with a pin 

feed attachment. The drum then rotates the paper as pens move across it and 
draw the image. It is used to produce continuous output, such as plotting of 
earthquake activity. It is also known as Roller Plotter. 

(ii)​ Flatbed plotter - It plots on paper that is spread and fixed over a rectangular 
flatbed table. It is used in the design of cars, ships, aircrafts, buildings, 
highways etc. It is also known as Table Plotter. 

 



 

4.​ Speaker - Speakers are one of the output devices used with computers. They 
are transducers that convert electromagnetic waves into sound waves. 

 
5.​ Digital Projectors – Projector is a device that connects with a computer and 

projects the output onto a white screen or wall. 
 

An Operating System (OS) is a program that acts as an interface between a computer 
user and computer hardware. It performs all the basic tasks and controls the 
peripheral devices such as disk drives and printers. 

Examples – Linux (Ubuntu), Windows (Windows XP, Windows 7, Windows 8, Windows 
8.1, Windows 10), iOS, Chrome OS, DOS etc. 

Apple’s latest operating system, macOS Mojave, version 10.14. 
 

 



 

 

 

The operating system is the manager of all system resources. The functions of 
operating systems are: 

�​ Memory Management 

�​ Process Management 

�​ Device Management 

�​ File Management 

�​ Storage Management 

�​ Security 

�​ Job Accounting 

�​ Controls system performance 

�​ Error detecting aids 

�​ Coordination between other software and users 

Memory Management - Memory management is the process of controlling and 
coordinating computer memory, conveying memory blocks to various running 
programs to enhance overall system performance. 

Process Management – Process Management allocates the processor (CPU) to a 
process and de-allocates the processor when a process is no longer essential. It can 
save the tracks of the processor and the status of the process. 

 
Device Management – Device Management keeps track of all devices. This is called the 
Input/output controller and it decides which process gets the device, when, and for 
how long. 

 
File Management – File Management allocates and de-allocates the resources. It keeps 
track of information, location, uses, status etc. The collective facilities are known as a 
file system. 

 
Storage Management – Storage Management provides secondary storage to backup 
main memory. It can store all data and program permanently. Disk scheduling, 
Storage allocation, Free space management are the activities in Storage Management. 

 
Security – Security controls the unauthorized access of programs, processes and data 
resources by means of passwords etc. It can be used to ensure that the files, memory 
segment, and other resources can be operated only by authorized users. 

 
Job Accounting – It keeps track of time and resources used by various users and 

 



 

processes. 

Control System Performance – Control System records delays between the request for 
a service and from the system. 
Error Detecting Aids – Error detecting Aids ensure the consistent delivery of data 
across the network. Production of dumps, traces, error messages and other 
debugging etc are techniques that enable reliable delivery of digital data over 
unreliable communication channels. 

 



 

Coordination between other software and users - Operating System Coordinates and 
assigns compilers, interpreters, assemblers and other software to the various users of 
the computer systems. 

 

�​ Batch Operating System 

�​ Multi-Programming Operating System 

�​ Timesharing/Multitasking Operating System 

�​ Distributed Operating System 

�​ Real-Time Operating System 

�​ Single-user operating System 

Batch Operating System - The users of the batch operating system do not interact 
with the computer directly. Each user prepares his job on an off-line device like punch 
cards and submits it to the computer operator. 
Disadvantages 

✔​ Lack of interaction between the user and the job 

✔​ The speed of the process is slow. Hence Output is time taking 

✔​ The CPU is in idle condition 

Multiprogramming Operating System – The users of multiprogramming operating 
system can execute several programs simultaneously. The CPU keeps on processing. 
The processes which are running exist in main memory at a time. 
Disadvantages 

✔​ The waiting time for the job is high 

✔​ Complicated schedule handling 

 
Timesharing / Multitasking Operating System - Time-sharing or multitasking is a 
logical extension of multiprogramming. It is a technique which enables many people, 
located at various terminals, to use a computer system at the same time. The CPU 
executes multiple programs by switching among the programs. Unix is an example of 
timesharing OS. 
Disadvantages 

✔​ Less Reliability 

✔​ Problem of Data Communication 

Distributed Operating System – Distributed Operating System allows multiple users on 
different computers or terminals to access a single system with one Operating System 

 



 

on it. The processors communicate with one another through various communication 
lines. These are referred to as loosely coupled systems. 
Advantages 

✔​ Potential Operation 

✔​ Better service to the customers. 

✔​ The load on the host computer is reduced 

✔​ Delays in data processing are reduced 

 



 

Single User Operating System – This type of operating system supports a single user 
at any given time. Single keyboard and Single monitor are used for interaction. 
Several programs can also run by a single user in this operating system. 

Example – Windows 95, Windows XP etc 

Real-Time Operating System – It is a data processing system in which the time 
interval required to process and respond to inputs is small. It is always online whereas 
online system need not be real time. They are used in scientific experiments, medical 
imaging systems, industrial control systems, weapon systems, robots, air traffic 
control systems, etc. 
Examples – VRTX, RT Linux, Lynx etc 

 
There are two types of real-time operating systems. 

 
✔​ Hard real-time systems - In this system, the critical tasks complete on time. 

Secondary storage is limited, and the data is stored in ROM. Virtual memory is 
almost never found. 
Examples – Industrial control applications, Robots, etc 

✔​ Soft real-time systems - In this system, the time constraint is less strict. A 
critical real-time task gets priority and retains the priority until it completes. It 
has limited utility. 
Examples – Multimedia, Virtual reality, Advanced Scientific Projects like 
undersea exploration and planetary rovers, etc. 

Advantages 

✔​ It can be used in an embedded system 

✔​ Error-free 

✔​ Better memory 
allocation Disadvantages 
✔​ Algorithm is complex 

Android - Android is the name of the operating system used on many smartphones 
and tablets. It is owned and maintained by Google. The recent version of Android is 
Android 9 Pie. 

 

Booting - When the computer starts, the operating system is first loaded (as it is 
essential for running all other programs), this process is known as booting. 

 
Cold Boot – Turn ON the computer from an OFF position is called Cold Booting. 

Warm Boot - A computer system starts up/reset from a complete powerless state is 
called Warm Booting. 

Firmware - Firmware is a software program that is written to a hardware device. It 
allows the hardware to be updated. The contents are saved when a hardware device is 

 



 

turned off or loses its external power source. 

Middleware - Middleware is a software layer situated between applications and 
operating systems. It enables communication and data management for distributed 
applications. 

 



 

 

 

The software is a group of instructions that instructing a computer to do specific 
tasks. It enables the user to interact with a computer. System Software and 
Application Software are two types of software. 

 

It serves as an interface between a computer user, computer hardware and 
application software. It is also known as background software. Four types of system 
software are the following. 

✔​ Operating System 

✔​ Utility Programs 

✔​ Device drivers 

✔​ Language translators. 

Operating System - Operating system (OS) is the program that acts as an interface 
between the user and computer hardware and application software. After the boot 
program, OS manages all the other programs in a computer. Examples - Linux, Unix, 
Microsoft Windows XP etc. 

Utility Programs - Utility Programs help to manage, maintain and control computer 
resources. They are also known as service programs. Examples of utility programs are 
antivirus software, backup software, disk defragment, backup, disk clean etc. 

Device Drivers - A device driver is designed to enable interaction with hardware 
devices. It controls a device that is attached to your computer. Printers, Displays, CD- 
ROM readers, Disk drives etc are the examples of the device driver. 

Language Translator – Language Translator translates the high-level language 
program (input) into an equivalent machine language program (output). It also 
detects and reports the error during translation. Assembler, Compiler, Interpreter are 
types of a Language Translator. 

Assembler – It converts assembly language program into machine language. 

Compiler – It converts the program in a high-level language into low-level language 
and reports all the errors of the program along with the line numbers. C, C++ use 
compilers. 

Interpreter – It converts the programs in a high-level language to low-level language. 
It translates line by line and reports the error once after completing the translation 
process. It gives better error diagnostics than a compiler. Python, BASIC, and Ruby 
use interpreters. 

 



 

 

 

Application software is a program or group of programs designed for end users. It 
enables the user to complete tasks, such as creating documents, spreadsheets, 
databases, and publications, doing online research, sending email, designing graphics 
etc. There are two types of application software. 

✔​ Basic application software 

✔​ Specialized application software 

Basic application software - Basic application software is also known as general 
purpose applications and productivity applications. These programs are widely used 
in every discipline and occupation. Word processors, spreadsheets, database 
management systems, and presentation graphics are the common types of basic 
application software. Example - Microsoft office 2016. 

Specialized application software - Specialized application software is designed for a 
specific task rather for a wide application area. Graphics programs, audio and video 
editors, multimedia creation programs, web authoring, and virtual reality programs 
are common types of specialized software. 

 

The different kinds of languages have been developed to perform various types of 
work on the computer. The two major types of programming languages are Low-Level 
Languages and High-Level Languages. 

 

It is a programming language that deals with a computer's hardware and its 
configuration. It is very close to the computer’s native language. It is further divided 
into Machine and Assembly languages. 

Machine Language – It consists of binary digits or bits. It can directly understand by 
the computer and does not need a translator program. It is also called the machine 
code. It is efficient but difficult to learn. 

Advantages 

�​ Programs run fast. 

�​ No translation program is required. 

Disadvantages 

�​ Difficult to program 

�​ Debugging is also an issue 

 



 

 
Assembly Language – A combination of letters and numbers forms the Assembly 
Language and a translator program is required to translate to the machine language. 
The operation codes and operands are given in the form of alphanumeric symbols 
which are known as mnemonic codes and can combine in a maximum of five-letter 
combinations e.g. ADD for addition, SUB for subtraction etc. This is also known as 
Symbolic Programming Language. 

Advantages 

�​ Easier to understand and minimizes effort. 

�​ Finding and correcting the errors are easy. 

Disadvantages 

�​ It is machine dependent (program written for one computer might not run 
in other computers with different hardware configuration) 

�​ Writing of code is time-consuming. 
 

A high-level language (HLL) is a programming language that enables a programmer to 
write programs independently. Such languages are closer to human languages. Higher 
level languages are simple languages that use English and mathematical symbols like 
+, -, %, / for its program construction. 

Example – BASIC, C, C++, COBOL, FORTRAN, ALGOL, PASCAL, PROLOG. 

BASIC - Beginner's All-purpose Symbolic Instruction Code (BASIC) was developed for 
students to write simple computer programs. It was designed by John Kemeney and 
Thomas Kurtz in 1963. 

ALGOL - ALGOL is a short form of ALGOrithmic Language. It is a family of portable 
programming languages for scientific computations. 

PROLOG - Prolog is used widely for artificial intelligence applications, particularly 
expert systems. 

PASCAL - It is used to teach programming techniques. It was developed by Niklaus 
Wirth. 

FORTRAN - It is a programming language designed for numeric computation and 
scientific computing. FORmula TRANslation is an acronym of FORTRAN. 

COBOL - Common Business Oriented Language is the full form of COBOL. It is used for 
business and administrative purposes. It can be read like regular English. 

C – It is a general-purpose language which is used in many scientific programming 
situations. 

 



 

 
C++ - C++ is an object-oriented programming language and incorporates all the 
features offered by C. 

Advantages 

�​ Independent of machines and can run on any computer 

�​ Problem-oriented rather than machine oriented 

�​ User-friendly 

Disadvantages 

�​ Need time for translating. 
 

Object-oriented programming (OOP) is a software programming model built around 
objects. This model classifies data into objects and describes object contents and 
performance through the declaration of classes. 

Simula is the first object-oriented programming language. The examples of object- 
oriented programming languages are Java, Python, JavaScript, C++, C#, PHP, Perl, 
.NET, Ruby Curl, Visual Basic, Smalltalk, Delphi, and Eiffel. 

Java - Java is used for developing Mobile, Desktop, web, server-side and dynamic web 
applications. 

JavaScript – JavaScript is designed for styling HTML Pages, interactivity to HTML 
Pages, Server-Side Scripting Operation, executing query related to DB on Serve. 

Python - Python is a general-purpose programming language. It is used for developing 
complex scientific, numeric applications, data analysis, and visualization. 

C# - C# is a general-purpose language was designed by Microsoft to be used for 
developing apps on the Microsoft platform. 

PHP - PHP stands for Hypertext Pre-processor. It is a scripting language used for the 
development of web applications. 

.Net-.Net is a programming framework developed by Microsoft, which can be used to 
build different types of applications such as Windows, Web application and Mobile 
based applications etc. 

Visual Basic - Visual Basic is an approachable language with a simple syntax for 
building type-safe, object-oriented apps. 

 



 

 

Computer Languages Father/Inventor/Designed by 

C/C++ Dennis Ritchie 

Java James Gosling 

JavaScript Brendan Eich 

PHP Rasmus Lerdorf 

Python Guido van Rossum 

HTML Tim Berners-Lee 

.NET (Framework) Microsoft Corporation 

C# Microsoft Corporation 

Perl Larry Wall 

Ruby Yukihiro Matsumoto 
 

Language Processor – Language Processor is a software designed to perform tasks 
such as processing program code to machine code. Language processors are found in 
languages such as Fortran and COBOL. 

Debugger - A debugger is a software utility that is designed to locate errors within a 
program's source code. 

Linker - Linker is a program that combines object modules to form an executable 
program. 

Loader – Loader brings all program objects into the memory which is essential to run a 
program. 

Spooling - Spooling is a process in which data is temporarily held to be used and 
executed by a device, program or the system. Data is saved in storage until the 
program requests it for execution. 

 



 

 

 

 
S.No Unit Description 

1 
Bit 
(Binary 
Digit) 

A binary digit is the smallest unit. It has the logical representation 
of 0 and 1. 

2 
Nibble A group of 4 bits is called nibble. 

3 
Byte A group of 8 bits is called byte. (1 byte = B bits) 

4 
Word A computer word is a group with a fixed number of bits processed 

as a unit. The length of a computer word is called word-size or 
word length and it may be either 8 bits or 96 bits. 
A computer stores the information in the form of computer words. 

Memory Capacity Conversion Chart 
 

Term Approximate Size 

Byte (B) 
8 bits 

Kilobyte (KB) 1024 bytes / 103 bytes 

Megabyte (MB) 
1024 KB / 106 bytes 

Gigabyte (GB) 
1024 MB / 109 bytes 

Terabyte (TB) 1024 GB / 1012 bytes 

Petabyte (PB) 
1024 TB / 1015 bytes 

Exabyte (EB) 
1024 PB / 1018 bytes 

Zettabyte (ZB) 
1024 ES/ 10 21 bytes 

Yottabyte (YB) 1024 ZB/ 1024 bytes 
 

The Number system is a technique to represent and work with numbers. The most 
widely adopted number system is the Decimal number system which has 10 digits (0- 
9). Binary number system (0,1), Octal number system (0-7) and Hexadecimal number 
system (0-9, A, B, C, D, E, F) are other number systems. 
The number of digits in a system is called ‘radix’ or ‘base’. The base of decimal, 
binary, octal hexadecimal system is 10, 2, 8 and 16 respectively. 

 



 

Comparison of Decimal, Binary, Octal and Hexadecimal system. 
 

Decimal Binary Octal Hexadecimal 

0 
0000 0 0 

1 
0001 1 1 

2 
0010 2 2 

3 
0011 3 3 

4 
0100 4 4 

5 
0101 5 5 

6 
0110 6 6 

7 
0111 7 7 

8 
1000 10 8 

9 
1001 11 9 

10 
1010 12 A 

11 
1011 13 B 

12 
1100 14 C 

13 
1101 15 D 

14 
1110 16 E 

15 
1111 17 F 

16 
10000 20 G 

 

 



 

 

 

These are the building blocks of any digital circuit that implement Boolean logic 
processes. It has only one output. Arrays of logic gates are used in digital integrated 
circuits (ICs). The basic logic gates and their functioning (truth table) are mentioned 
in the following figure. 

AND Gate 

It is a digital logic gate with two or more inputs and one output which performs logical 
conjunction. 

 

A B AB 

0 0 0 

0 1 0 

1 0 0 

1 1 1 
 

OR Gate 

It is a logic gate that produces inclusive disjunction. It is used in Boolean algebra and 

electronic circuits like transistor-transistor logic, and complementary metal-oxide 
semiconductors etc. 

 

A B A+B 

0 0 0 

0 1 1 

1 0 1 

1 1 1 
 

 



 

 
NOT Gate 

NOT gate is a single input gate. It performs the inversion of given input. So, it is called 
Inverter. 

 

A 
 

 

0 0 

0 1 

1 0 

1 1 

 

NAND Gate 

It is the combination of AND & NOT gates. It is the opposite of AND logic gate. 

 

A B 
 

 

0 0 1 

0 1 1 

1 0 1 

1 1 0 
 

NOR Gate 

It is the combination of NOT & OR gates. ‘neither this nor that’ is the principle of NOR 

gate. 
 

A B 
 

 

 



 

0 0 0 

0 1 0 

1 0 0 

1 1 1 
 

 



 

 
XOR Gate 

XOR gate is a special type of gate. It is used in the half adder, full adder and 
subtractor and controlled inverter circuit. It is also used in the computers for 
implementing the binary addition. 

 

A B A⊕B 

0 0 0 

0 1 1 

1 0 1 

1 1 0 
 

XNOR Gate 

It is a combination of the Exclusive-OR gate and the NOT gate. The EXOR gate has a 

high output only when an odd number of inputs are high. 
 

A B 
 

 

0 0 1 

0 1 0 

1 0 0 

1 1 1 
 

 



 

 

 

A database management system (DBMS) is a computer program designed for creating 
and managing the database. It provides a systematic way to run operations like 
creating, storing, retrieving, deleting data from the database. It serves as an interface 
between the database and end users. It also provides protection and security to the 
databases. 

MySQL, Oracle, SQL Server, IBM DB2, PostgreSQL, Amazon Simple DB (cloud-based) 
are some popularly used DBMS. 

Advantages of DBMS 

✔​ Reduced Data redundancy 

✔​ Data security and consistency 

✔​ Easily accessible 

✔​ Integrity constraints 
Disadvantages of DBMS 
✔​ Larger in size 

✔​ Complexity 

✔​ Licensed DBMS are costly 
 

Database systems consist of complex data structures. The process of masking 
irrelevant information from users is known as Data Abstraction. Data abstraction 
reduces the complexity of users with the database. Three levels of data abstraction 
are Physical Level, Logical Level, and View level. 

 
The Architecture of commercial DBMS is based on ANSI-SPARC database architecture. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 

 
Physical Level/Internal Level - It is the lowest level of abstraction. It describes how the 
data is physically stored in detail. B+ tree, Hash file organization methods are used in 
this level. 

Logical Level/Conceptual Level - It is the next level of abstraction and describes what 
data is stored and what is the relationship among that data. At the logical level, each 
record is described by a type and the interrelationship of these record types. Database 
administrators work at this level of abstraction. The changes which are done at this 
level will not affect the external or physical levels of data. 

 
View Level/External Level - It is the highest level of abstraction and is viewed by the 
user in terms of tables and relations. It describes only a part of the entire database 
and hides the details of the logical level. 

 

A key is a field in the database table which is used to retrieve and sort rows in the 
table. Keys are used to speeding up the data accessing and creating links between 
different tables. 

 
Super Key - It is a set of one or more attributes whose values uniquely determine 
each entity in the database table. It is a subset of a candidate key. 

 
Candidate Key - It is a set of columns in the table from which primary key can be 
selected to identify each record. Every database table may have one or more 
candidate keys. 

Primary Key - It is a special key that uniquely identifies each record in the table. It has 
a unique value for each row of data and it cannot contain null values. 

 
Composite Key - It is a combination of more than one column in the table that can be 
used to uniquely identify each record. It is also known as a Compound key. 

Alternate Key - All keys except primary key are known as Alternate. Alternate keys are 
also called Secondary Keys. 

 
Foreign Key - Foreign key points to the primary key of another table. It acts as a 
reference between tables. It can accept the null and duplicate value. 

 



 

Microsoft Office​  
It is an office suite of inter-related desktop applications, servers and services for the 
Windows operating systems introduced by Microsoft in 1989. Some important 
application software of the MS Office is MS Word, MS Excel, MS Power-point, MS 
Access, MS OneNote, MS Outlook etc. 

 

Microsoft Word is a word processing program that was first made public by Microsoft. 
It is one of the most widely used word processors available for Macs and PCs. It offers 
a variety of features such as creating, editing and formatting etc. Some other features 
include spell check, mail merge and link embedding. Another feature is word 
wrapping, which means that the processor automatically adjusts all text within the 
specified margins. ‘.doc and .docx’ are the file extension of MS word. 

Title Bar 

The title bar is located at the top of a window that displays the name of the window or 
document being used. 

Quick Access Tool Bar 

The quick access toolbar is a small and customizable toolbar at the top of the 
document window. It contains a set of commands that are independent of the tab on 
the ribbon that is currently displayed. It usually contains buttons to save, undo, redo 
and print. 

Ribbon 

The Ribbon is a cluster of toolbars in Microsoft Office which are used for writing, 
designing, formatting and reviewing different styles, adaptations, add-ins, themes etc. 
Every tab in the top of a given word file window displays the Ribbon toolbar. 

The following are the specifications of MS office 2016 version. 

File Menu 

The File menu is a section on the Office ribbon that gives access to file functions such 
as Open, Save, Close, Properties, and Recent file options. Type of file (i.e. Text file, 
Word file, HTML file, etc.), file name, size of the file, file location, security on the file, 
time and date of creation, modification of the file can also be accessed by anyone. 

 



 

 
Home Tab 

The Home tab is the default tab in Microsoft Word, Microsoft Excel, Microsoft 
PowerPoint and other Microsoft Office products. It allows changing document settings, 
such as the font properties by using control groups on the tab. The control groups and 
keys are 

✔​ Clipboard Group (Copy (only one item at a time), Paste, Cut, Format Painter) 

✔​ Font Group (Font style, colour & size, Bold, Underline, Strikethrough) 

✔​ Paragraph Group (Bullets & Numbering, Alignment, Shading, Borders, Line 
spacing) 

✔​ Style Group (Listed Styles) 

✔​ Editing Group (Find, Replace etc). 

Insert Tab 

The Insert Tab is used to insert different features such as tables, pictures, clip art, 
shapes, charts, page numbers, word art, headers, and footers etc into a document. 
The availed groups and keys under this tab are: 

✔​ Pages Group (Cover page, Blank page, Page break) 

✔​ Tables Group (Tables) 

✔​ Illustrations Group (Pictures, Shapes, Smart Art etc) 

✔​ Media and Links Group (Hyperlink, Bookmark etc) 

✔​ Header and Footer Group (Page number, Header, Footer) 

✔​ Text Group (Text Box, Word Art etc) 

✔​ Symbol Group (Equation, Symbol) 

Design Tab 

Design Tab includes Themes (to change colours, fonts and effects for the document all 
at once), The Style Set gallery (to change the styles), Paragraph Spacing, Effects, The 
Page Background group (watermark, page colour, page borders) buttons to format the 
document. 

Layout Tab 

The Layout Tab holds the buttons which are used to arrange document pages. The 
control groups and keys under layout tabs are: 

✔​ Page Setup Group (Margins, Orientation, Breaks, Line numbers, Hyphenation, 

 



 

Size of the page, Columns) 
✔​ Paragraph Group (Paragraph Indentation, Spacing) 

✔​ Arrange Group (Align, wrap text, Rotate etc) 

 



 

 
References Tab 

References Tab allows to now create a table of contents, footnotes, citations, cross- 
references. The availed control groups and keys in this tab are: 

✔​ Table of Contents Group (Customize table of contents) 

✔​ Footnotes Group (Insert footnotes) 

✔​ Research Group (Smart outlook of the text) 

✔​ Citations & Bibliography Group (Inserting and choosing a style of citation, 
Bibliography) 

✔​ Captions group (cross reference, insert a table of figures, Insert Caption) 

✔​ Index Group (Insert Index, Mark entry) 

✔​ Table of Authorities group (Mark Citation, Insert Table of Authorities) 

Mailings Tab 

Mail Merging is an ideal task in MS word by using Mailings Tab. Mail merge is used to 
create form letters or address labels, certificates with unique names, and more. The 
following group buttons are available in Mailings Tab. 

✔​ Create Group (Envelops, Labels) 

✔​ Start Mail Merge Group (Start Mail Merge, Selection of Recipients, Edit Recipient 
List) 

✔​ Write & Insert Fields Group (Highlighting the fields, Address Block, Greeting Line 
etc) 

✔​ Preview Results Group (Check for errors, Find Recipient) 

✔​ Finish Group (Finish & 

Group) Review Tab 

The tools in the Review Tab helps to improve the document. It contains the following 
control groups and keys. 

✔​ Proofing Group (Spelling & Grammar, Thesaurus, Autocorrect, word count) 

✔​ Comments Group (Add new comment, show comment, Delete comment) 

✔​ Tracking Group (Track changes, Simple mark-up, Review pane) 

✔​ Changes Group (Accept or Reject changes) 

 



 

✔​ Compare Group (Comparing the documents) 

✔​ Protect Group (Restrict editing, Block Authors) 

View Tab 

The View tab has the functionality to change the document views. The options in the 
view tab are: 

✔​ Views Group (Read mode, Print Layout, Web Layout Outline, Draft) 

✔​ Page Movement Group (Vertical and Side to side) 

✔​ Show Group (Ruler, Gridline, Navigation Pane) 

✔​ Zoom Group (Zoom {10% to 500%}, Page width, Multiple pages) 

✔​ Window Group (New window, Arrange and Split window, Switch windows etc) 

✔​ Macros group 

 



 

 
Help Tab 

The users can get help by using F1 function key anytime, Help tab and ‘Tell me what 
you want to do’. 

Status Bar 

A status bar is a horizontal window at the bottom of a parent window. It displays the 
various kinds of status information of the document. 

Dialog Box Launcher 

A button in the corner of a group that launches a dialog box containing all the options 
within that group. 

View Toolbar 

A toolbar that enables, adjusts and displays different views of a document. It is 
located at the bottom left corner of the window. 

Other Terms 

Alignment – This option is used to align the text in a document adhere to the right 
side, left, centre or justified. 

Clipboard – The clipboard saves the text temporarily. Using the Cut or Copy 
commands will place the text in the clipboard. 

Font – It is a type of design for text. Times New Roman, Arial, Calibri, Verdana etc are 
the examples of font style. The maximum size of Font is 72 in a drop-down selection 
of MS Word. 

Undo and Redo – Undo refers to delete the last action in the document. Redo can 
restore the changes again. 

Footer and Header - The footer constantly appears on every page of a document, at 
the bottom of each page. It includes the page number, or a company’s name and 
contact details in formal documents. The header sits at the very top of every page in 
a document. A Header contains page numbers, the document name or sub-titles 
within a document. 

Cut, Copy, Paste - Cut is used to move a section of text from a document to clipboard. 
Copy refers to duplicating a section of a document and placing it in the clipboard. 
Paste allows to copy an object or text from one location and place it to another 
location. 

Paste Special - Paste Special is used to paste an item from the clipboard with custom 
formatting. 

Thesaurus - It is a software tool which is in MS Word that provides synonyms for 
selected words on command. 

AutoCorrect - AutoCorrect is a software feature in MS Word. It automatically corrects 
misspellings and common errors. 

 



 

 
Spell Check - It is a software tool for correcting spelling. It is available in word 
processing programs, email programs, cell phones, and a variety of other applications. 

Shortcut Keys 
 

Keys Description Keys Description 
Ctrl + A Select All Shift+F7 Thesaurus 
Ctrl + B Bold F1 Help 
Ctrl + C Copy F5 Refresh the page 
Ctrl + V Paste F4 Repeat the action 
Ctrl + N New Blank Document F7 Spell Check 
Ctrl + X Cut F6 Go to the next pane 
Ctrl + I Italic F8 Extend the selection 
Ctrl + U Underline F9 Update the selected fields 
Ctrl + Z Undo F10 Show Key tips 
Ctrl + Y Redo F11 Go to the next field 
Ctrl + O Open F12 Save As 
Ctrl + S Save Shift + F3 Change the case of letters 
Ctrl + K Insert Hyperlink Shift + F4 Repeat a find 
Ctrl + L Left Alignment Shift + F10 Display a shortcut menu 
Ctrl + E Centre Alignment Ctrl + F2 Choose Print Preview 
Ctrl + R Right Alignment Ctrl + F4 Close the window 
Ctrl + J Justify the alignment Ctrl + F10 Maximize the document window 
Ctrl +F To open find box Ctrl + F12 Choose the open button 
Ctrl + G Find and Replace Tab To move to the previous object 
Ctrl + W Close document Alt + F5 Restore the program window 
Ctrl + M Indent Alt + F7 Find the next misspelling 
Ctrl + P Print Alt + F10 Maximize the program window 
Ctrl + Shift +> Increase font size F2 Rename the file 
Ctrl + Shift + < Decrease font size Alt + F4 Exit 
Alt + H Home Tab Alt + P Layout Tab 
Alt + N Insert Tab Alt + Q Tell me box 
Alt + G Design Tab Alt + R Review Tab 
Alt + F File Page Alt + W View Tab 
Alt + M Mailings Tab Alt + S Reference Tab 

 

 



 

 

 

It is a spreadsheet program which is used to present and organise copious amounts of 
data in a systematic manner. It also includes performs basics arithmetic operations on 
data and creates graphs and charts based on the same.’.xls’ is the file extension of the 
MS Excel. Ribbons in MS Excel are divided into logical groups called Tabs and Each tab 
has its own set of unique function to perform. There are various tabs – Home, Insert, 
Page Layout, Formulas, Date, Review and View. 

The following are the features of MS Excel 2016. 

Home Tab 

The Excel Home Tab is used to perform common commands such as bold, underline, 
alignment, Number, copy, and paste. It is also used to apply formats to cells in a 
worksheet. The Home Tab groups and their buttons are: 

✔​ Clipboard Group (Paste, Cut, Copy, Format Painter) 

✔​ Font Group (Bold, Italic, Underline, Font Style, Colour & Size {decrease and 
increase}, Fill colour, Borders) 

✔​ Alignment Group (Alignment {Top, Middle, Bottom, Left, Right, Centre}, 
Orientation, wrap text, Merger& Centre, Indent decrease & increase) 

✔​ Number Group (General, Accounting Number Format, Percent style, Comma 
style, Increase and decrease decimal) 

✔​ Styles Group (Conditional Formatting, Format as Table, Cell Styles) 

✔​ Cells Group (Insert cells, Delete cells, Format cells) 

✔​ Editing Group (AutoSum, Fill, Clear the format, Sort& Filter, Find & Select) 

Insert Tab 

Insert Tab is used to insert the picture, charts, filter, hyperlink etc. Alt+N is the 
shortcut Key to open Insert Tab. The Insert Tab groups and keys are: 

✔​ Tables Group (Pivot Table, Recommended Pivot Tables, Table) 

✔​ Illustrations Group (Pictures, Online pictures, Icons, Shapes, Smart Art Graphic, 
3D models, Screenshot) 

✔​ Add-ins Group (Store, Insert Add-ins) 

✔​ Charts Group (Recommended charts, Maps, Pivot Chart Charts*) 

✔​ Tours Groups (3D Maps) 

✔​ Sparklines Group (Line, Column, Win/Loss) 

 



 

✔​ Filters Group (Slicer, Timeline) 

✔​ Links Group (Hyperlink) 

✔​ Text Group (TextBox, Header & Footer), WordArt, Signature line, Object) 

✔​ Symbols Group (Equation and Symbol) 

*Charts – There are eight types of charts. Colum or Bar Chart, Hierarchy Chart, Line 
or Area Chart, Combo Chart, Statistic Chart, Bubble Chart, Pie Chart, Waterfall, 
Funnel, Stock, Surface or Radar Chart. 

 



 

 
Page Layout Tab 

The features under this tab used to change the look of a workbook. The groups 
under this tab are: 

✔​ Themes Group (Themes, Colours, Fonts, Effects) 

✔​ Page Setup Group (Margins, Orientation, Size, Print Area, Breaks, Background, 
Print Titles) 

✔​ Scale to fit Group (Page scale, Width and Height) 

✔​ Sheet Options Group (Gridlines, Headings) 

✔​ Arrange Group (Bring Forward, Send Backward, Align, Group, Rotate, Selection 
Pane) 

Formulas Tab 

Formulas Tab is used to make dynamic reports by using functions. In excel, 461 
functions are availed from Office 2003 to 2013. Formulas Tab is divided into four 
groups. 

✔​ Function Library (Insert Function, AutoSum, Financial & Logical Function, Date 
&Time, Math& Trig, Lookup &Reference, Text, More functions {Statistical, 
Engineering, Cube etc}) 

✔​ Defined Names group (Name Manager, Define Name, Use in Formula, Create 
from selection) 

✔​ Formula Auditing (Trace Precedents & Dependents, Error Checking, Evaluate 
Formula, Watch window) 

✔​ Calculation Group (Calculate sheet, 

options) Data Tab 

Data tab is used for importing a large amount of data. Importing Data can be done by 
connecting with the server, automatically from the web, MS Access etc. It makes easy 
to read vast data. 

✔​ Get & Transform Data Group (Get Data, From Text/CSV, Web, Table/Range, 
Existing Connections) 

✔​ Queries & Connection Group (Refresh All, Properties, Edit Links, Queries, 
Connections) 

✔​ Sort & Filter Group (Sort, Filter, Reapply, Clear, Advanced) 

✔​ Data Tools Group (Text to columns, Flash Fill, Remove Duplicates, Data 
Validation, Consolidate, Manage Data Mode, Relationships) 

 



 

✔​ Forecast Group (What-If Analysis, Forecast Sheet) 

✔​ Outline Group (Group, Ungroup, Subtotal) 

 



 

 
Review Tab 

It contains the editing feature, comments, track changes and workbook protection 
options. It makes to share the data easily with the proper information and ensuring 
the security of data. 

✔​ Proofing Group (Spell Check, Thesaurus) 

✔​ Language Group (Translate) 

✔​ Comments Group (Comment – New, Delete, Previous, Next, Hide/Show) 

✔​ Protect Group (Protect Sheet, Protect Workbook, Allow Edit Ranges, Unshared 
workbook) 

✔​ Ink Group (Start Inking, Hide 

Ink) View Tab 

View tab helps to change the view of an Excel sheet and make it easy to view the 
data. This tab is useful for preparing the workbook for printing. The groups and keys 
under this tab are 

✔​ Workbook Views Group (Normal, Page Break Preview, Page Layout & Custom 
View) 

✔​ Zoom Group (Zoom {range – 10% to 400%}, Zoom to selection) 

✔​ Window Group (New Window, Arrange All, Freeze Panes, View side by side, 
Synchronous Scrolling, Reset Window, Show/Hide, Switch Windows) 

✔​ Macros Group (Macros) 

Help Tab 

The user can get help using this tab, by pressing F1 Key. 

✔​ Help & Support Group (Help, Contact Support, Feedback, Show Training, What’s 

New) 

✔​ Community Group (Community, Blog Site, Suggest a Feature) 

Other Terms 

Workbook – It is an Excel file which contains worksheets of rows and columns. 

Worksheet – A single document or sheet in a workbook which is used to store and 
work with data. It consists of rows and columns. In Excel 2016, Default worksheet in 
a workbook is one. 

Row & Column Headings – It indicates the number of rows (Left of the worksheet) and 
alphabet of column (Top of the worksheet). The total number of rows is 1,048,576 and 

 



 

columns is 16,384 in the new version of Excel sheet. Column width is 255 characters 
and row height is 409 points. 

Cell – Cell is a box which is the intersection of a row and column in a worksheet. It is 
the smallest block of the spreadsheet. The cell in which the user working is known as 
Active Cell. The maximum number of line feeds per cell is 253 in the new version of 
Excel. 

Cell Address – The location of a cell is known as Cell Address. Example: C10 (Column: 
Row) 

 



 

 
Autofill – Autofill fills the values in the cell according to a given pattern. (i.e. Months & 
Days, Even Numbers, Odd Numbers, tens, etc) This is done through the Fill Handle. 

Formula – It is an expression which calculates the value of a cell. It always starts with 
a ‘=’. 

Formula Bar – It is located just below the ribbon. It shows the contents of the active 
cell and allows to create and view formulas. 

Pivot Table – Pivot Table is an interactive report creation system. It is used to 
reorganize and summarize the data. 

Flash Fill – Flash Fill is used to identify the patterns in existing data. It copies only 
required data from one column to another. 

Freeze Panes – It is used to freeze rows/columns in place and making it visible when 
scrolling. Example – Header row visible 

Macro – It is a sequence of instructions that replace a repetitive series of keyboard 
and mouse actions to execute. It is used in MS Word and MS Excel. 

Status Bar – It is the Bar below the worksheet names that has a few buttons and 
indicators. 

Wrap Text –When text exceeds a column width/Height, wrap text automatically adjust 
the height/width of a cell to make all text visible. 

Sparklines –They are graphs that can fit into one cell and gives the information about 
the data. 

 



 

 
Shortcut Keys 

 

Keys Description Keys Description 
F2 Edit active cell Shift + F11 Insert new worksheet 
F5 Go to Dialog box Shift + F9 Calculate the active worksheet 
F9 Calculate worksheets Ctrl + Shift 

+; 
Time 

F4 Create an absolute Ctrl +; Date 
Tab Right one Cell F11 Create Chart 
Shift + Tab Left One Cell Ctrl + Shift + 

U 
Expand/Collapse formula bar 

Ctrl + Home To first Cell Alt + = Insert AutoSum formula 
Ctrl + End To Last Cell Ctrl + ~ Show/hide all formula 
Shift + 
Spacebar 

Select entire row Ctrl + Shift 
+@ 

Apply the time format 

Ctrl + 
Spacebar 

Select entire column Ctrl + Shift + 
# 

Apply the date format 

Ctrl + 9 Hide selected rows Ctrl + Shift + 
% 

Apply the percentage format 
without decimal 

Ctrl + 0 Hide selected 
columns 

Ctrl + Shift + 
$ 

Apply the currency format with 
two decimals 

Arrow Keys Move between Cells Alt + Enter Start a new line in the same cell 
Alt + 
Spacebar 

Display control Menu Ctrl + Shift + 
Home 

Extend the selection of the cells 

F1 Create Pivot Chart Alt + F1 Create Pivot Chart in the same 
worksheet 

 

MS PowerPoint is a popular presentation program and is used to create slideshows 
which comprise text, graphics, sounds and other animated media. Features such as 
word art, auto shapes etc. can also be added to the presentation. It is convenient for 
both school and office level work. ‘.ppt’ is the file extension of MS PowerPoint. The 
Ribbons in MS Power-point 2016 are divided into following tabs. 

Home Tab 

The Home Tab includes the commands for formatting presentations. The Keys and 
Groups under the Home Tab are: 

✔​ Clipboard Group (Cut, Copy, Paste, Format Painter) 

✔​ Slides Group (New slide, Layout, Reset, Section) 

✔​ Font Group (Font Style & size {Max. size is 96 in dropdown selection}, Text 
Shadow, Bold, Underline, Italic, Strikethrough, Clear All Formatting, Character 
Spacing, Change case) 

 



 

✔​ Paragraph Group (Bulleting, Numbering, Align Text, Text direction, Convert to 
SmartArt) 

✔​ Drawing Group (Shapes, Arrange, Quick Styles, Shape Fill, Shape Outline, Shape 
Effects) 

✔​ Editing Group (Find, Replace, Select) 

 



 

 
Insert Tab 

It is used to add features such as tables, pictures, clip art, shapes, charts, word art, or 
headers, and footers into a presentation. The groups and buttons in this tab are: 

✔​ Slides Group (New Slide) 

✔​ Tables Group (Draw/Add Table) 

✔​ Images Group (Pictures, Online Pictures, Screenshot, Photo Album) 

✔​ Illustrations Group (Shapes, Icons, 3D models, Smart Art, Chart) 

✔​ Add-ins Group (Store, Add-ins) 

✔​ Links Group (Zoom, Link, Action) 

✔​ Comments (Add comment, Edit& Delete Comment) 

✔​ Text Group (TextBox, Header & Footer, Word Art, Date & Time, Slide number, 
Object) 

✔​ Symbols Group (Equation and Symbol) 

✔​ Media Group (Video, Audio, Screen Recording) 

Design Tab 

The Design tab holds commands related to the presence of slides like page setup and 
slide orientation. The group and Keys under this tab are: 

✔​ Themes Group (Listed Slide Themes) 

✔​ Variants Group (Listed Variants) 

✔​ Customize Group (Slide Size, Format Background) 

✔​ Designer Group (Design Ideas) 

Transition Tab 

Transitions tab is used to add transitions to a slide and to customize transition effects. 
The group and Keys of Transition Tab are: 

✔​ Preview (to view slides) 

✔​ Transition to this slide (Listed transition, Effect options) 

✔​ Timing Group (Sound in slides, Duration, Apply to all slides, Advance slide) 

Animation Tab 

 



 

It is used to add animation to text in a slide and to manage the animation order. The 
Groups and Keys are: 

✔​ Preview Group (Slide’s Preview) 

✔​ Animation Group (Listed Animation, Effect Options) 

✔​ Advanced Animation (Add Animation, Animation Pane, Trigger, Animation 
Painter) 

✔​ Timing Group (Start, Duration, Delay of slides, Reorder Animation) 

 



 

 
Slideshow Tab 

This tab is used to finalize the slideshow details, timings, and more. The Keys and 
groups under this tab are: 

✔​ Start Slide Show Group (From Beginning, From Current Slide, Present 
Online, Custom Slideshow) 

✔​ Set up Group (Set up slideshow, Hide slide, Rehearse timings, Record Slide 
Show) 

✔​ Monitors Group 

Review Tab 

Review tab is used to check spelling, to collaborate by adding comments, and to 
access editor tools. The groups are: 

✔​ Proofing Group (Spelling, Thesaurus) 

✔​ Language Group (Translate, Language) 

✔​ Comments Group (New comment, Delete Previous/next Comment) 

✔​ Compare Group (Compare, Accept, Reject, End Review, reviewing Pane) 

✔​ Ink Group (Start inking, Hide ink) 

✔​ OneNote Group (Linked Notes) 

View Tab 

View tab is used to access the various presentation views, to show and hide the ruler 
and grid lines, and more. 

✔​ Presentation Views Group (Normal, Outline view, Slide Sorter, Notes Page, 
Reading view) 

✔​ Masters View Group (Slide Master, Handout Master, Notes Master) 

✔​ Show Group (Ruler, Gridlines, Guides, Notes) 

✔​ Zoom Group (Zoom {10% to 400%}, Fit to the window) 

✔​ Colour/Grayscale Group (Colour, Grayscale, Black &White) 

✔​ Window Group (New window, Arrange All, Cascade, Move Split) 

✔​ Macros Group (Macros) 

Other Terms 
 



 

Presentation – A Presentation is a collection of individual slides that contain 
information on a topic with audio, visual features. It makes an interaction between a 
speaker and an audience. 

Design Template - A PowerPoint template is a pattern of a slide whose format and 
colour scheme is used as the basis for other presentations. It can contain layouts, 
theme colours, theme fonts, theme effects, background styles, and even content. 

Master Slide – A slide that controls the properties such as theme, layout, background, 
colour, fonts, and positioning of all other slides in a presentation. 

Normal View - Normal view is used for creating, editing and viewing presentation 
slides. It contains all three view panes such as Slides, Outline and Notes. 

Greyscale - Grayscale is a variety of shades of grey (Black and white combination) 
without apparent colour. 

 



 

 
Notes Pane - It is used to add notes and graphics that apply to the current slide in the 
presentation. It is also used to print the notes. 

Slides Pane – Slide Pane displays the slides thumbnails. It allows the user to view and 
edit the slides. 

Outline Pane – Outline Pane displays the text from the slides. 

Slide Show View – It is used to display the presentation. It is the way to preview the 
presentation. 

Slide Sorter View – It shows all the slides in a presentation as thumbnails. It is used to 
reorganize, insert, delete and copy the presentation slides. 

Slide Timing – It is the time period that a slide seems on the screen. 

Task Pane – It allows to access commands like getting started, PowerPoint help, slide, 
new presentation etc related to a specific task. 

AutoContent Wizard - A wizard helps to create a presentation. It helps with a general 
structure and suggested topics based on the user’s view regarding the presentation 
output. 

Shortcut Keys 
 

Keys Description Keys Description 
Alt + W, Q Change the zoom Alt + N, X Insert textbox 
Alt + H, F and 
S 

Change the font 
size 

Alt + N, W Insert word art 

Alt + H, S and 
H 

Insert a shape Alt + F10 Maximize window 

Alt + G, H Select a theme Ctrl + D Duplicate Slide 
Alt + H, L Select a slide 

layout 
Ctrl + Shift + 
F 

Change Font Style 

Alt + N, P Insert a picture Shift + F3 Toggle cases 
Alt + H Home Tab Ctrl + Shift + 

Z 
Normal/Plain Text 

Alt + N Insert Tab Shift + F6 Move anticlockwise among 
pane 

Alt + S, B Start Slideshow Shift + F10 Display context menu 
Alt + F, X Close PowerPoint Ctrl + F5 Restore window to previous 

size 
Esc End the slideshow Alt + Q Search 
Alt + T Transitions Tab Alt + R Review Tab 
Alt + A Animations Tab Alt + G Design Tab 
F5 Slide Show Alt + W View Tab 

 

 



 

 

 

A file extension is a suffix at the end of a filename that specifies what type of file it is. 
It helps the operating system to understand the characteristics of the file. 

Example – filename.docx is the name of the document. ‘.docx’ is the file extension. 

List of File Extension 
 

File 
Extensio
n 

Meaning File 
Extensio
n 

Meaning 

.apk Android Package file .bin Binary file 

.txt Plain text file .py Python file 

.wks / .wps Microsoft Works Word 
Processor Document file 

.wsf Windows Script file 

.ods OpenOffice Calc spreadsheet 
file 

.exe Executable file 

.xlr Microsoft Works spreadsheet 
file 

.com MS-DOS command 
file 

.xls Microsoft Excel File .mp3 MP3 audio file 

.xlsx MS Excel Open XML 
spreadsheet file 

.wma Windows media 
audio file 

.pptx PowerPoint Open XML 
presentation 

.wpl Windows Media 
Player Playlist 

.ppt PowerPoint presentation .mpg/.mpeg MPEG Video file 

.db/.dbf Database file .avi Audio Video 
Interleave file 

.sql SQL Database file .flv Adobe Flash video 
file 

.tar Linux / Unix tarball file archive .mp4 MPEG-4 video file 

.bak Backup file .odt Open office writer 
doc file 

.tmp Temporary file .pdf PDF file 

.htm/.html HTML/Hypertext Markup 
Language file 

.js JavaScript file 

.png Portable Network Graphic 
image 

.php PHP Source file code 

.gif Graphical Interchange Format 
image 

.ps PostScript file 

.psd Adobe Photoshop Document 
image 

.max 3ds Max Scene File 

.jpg/.jpeg JPEG image .jsp Java Server Page file 

 



 

.sys Windows system file .cfg Configuration file 
 

 



 

 

 

A computer network or data network is a telecommunications network which allows 
computers to exchange data using a data link. The connections between nodes 
(computers on networks called nodes) are established using either cable media or 
wireless media. Vint Cerf and Bob Kahn are known as fathers of the Internet. 

 

✔​ Sender (Device) 

✔​ Sender Equipment (Encoder) 

✔​ Communication Channel (Cables, Wireless) 

✔​ Receiver Equipment (Decoder) 

✔​ Receiver (Device) 

Sender - Sender is a device that sends a message which can consist of text, numbers, 
pictures etc. It is also called source or transmitter. 

Sender Equipment - The encoder is a device that converts digital signals in a form that 
can pass through a transmission medium. 

Communication Channel - It is the physical path that connects the sender and the 
receiver. It is used to transmit data. It is also called Medium. The channel can be a 
copper wire, a fiber optic cable, microwaves etc 

Receiving Equipment - The decoder is a device that converts the encoded signals into 
digital form. The receiver can understand the digital form of message. 

Receiver – Receiver is a device that receives the message. It is also called a sink. It 
must be capable of accepting the message. 

 

The Network allows computers to connect and share resources with other devices 
through a medium. 

Based on the area coverage, there are three types of computer networks. 

✔​ LAN – Local Area Network 

✔​ MAN – Metropolitan Area Network 

✔​ WAN – Wide Area Network 

Local Area Network 

LAN is a computer network covering a small geographical area and is privately owned. 
The Communication medium used for LAN has twisted pair cables and coaxial cables. 
LAN offers high-speed communications data rates up to 1000 Mbps. The fault 
tolerance of a LAN is more, and congestion is less in this network. LAN can be used for 

 



 

an office building, home, hospital, schools, etc. 

 



 

 
Metropolitan Area Network 

MAN covers a large geographical area than LAN. It is designed for customers who 
need a high-speed connectivity and it is usually owned by large organizations to 
interconnect its various branches across a city. The fault tolerance of a MAN is less 
and congestion in the network is more. Modem and Wire/Cable are used as 
transmission devices. It may serve as an Internet Service Provider (ISP). 

Wide Area Network 

WAN covers the large geographical area and it might be restricted within the bounds 
of a state or country. It could be a connection of LAN connecting to other LAN through 
telephone lines and radio waves. The technology is high speed and relatively 
expensive. 

The Speed of WAN ranges from few kilobits per second (Kbps) to megabits per second 
(Mbps). Public packet networks, Large corporate networks, Military networks, Banking 
networks, Stock brokerage networks, and Airline reservation networks are constructed 
by WAN. 

Other types 
Wireless Local Area Network (WLAN) - WLAN is a wireless network communication 
over short distances. This distribution method uses high-frequency radio waves and 
often include an access point to the Internet. It is also called Local Area Wireless 
Network (LAWN). 

Example - A mobile user can connect to LAN via wireless connection. 

Storage Area Network (SAN) - SAN is a high-speed special-purpose network. It 
supports data storage, retrieval, and sharing of data, multiple disk arrays, data 
migration from one storage device to another and uses Fibre Channel interconnection 
technology. 

Campus Area Network (CAN) - CAN is a computer network of interconnected local area 
networks. It is larger than a LAN but smaller than MAN or WAN. It can also stand for 
Corporate Area Network. 

Example - Massachusetts Institute of Technology’s (MIT) Project Athena has CAN 
network. 

Personal Area Network (PAN) - PAN refers to the interconnection of 
telecommunications devices or gadgets such as a laptop, mobile phones, printers etc 
around an individual person. It can cover a network range of 30 feet (approximately 
10 m). It can be constructed by using cables or it may be wireless. 

Wireless Personal Network (WPAN) – WPAN is a type of personal area network. It uses 
wireless communication to transfer data between the connected devices of the user. It 
is also known as short wireless distance network. 

 



 

 

 

It is the physical and logical design which denotes to the software, hardware, 
protocols and the media of transmission of data. Peer-to-Peer (P2P) and Client/Server 
or tiered are the two types of widely used network architecture. 

Peer-to-Peer Architecture - Tasks are allocated to all the devices of the network. There 
is no hierarchy among the computers and all of them are considered equal. All 
computer can able to use resources available on this network. This is also known as a 
distributed architecture. It doesn’t use a server that controls network activity. Peer-to- 
peer is mostly used for file sharing. 

Client/Server Architecture – The server acts as a hub in which other computers 
(clients) are connected. The server manages and provides resources to any client that 
requests them. 

 

Protocol - Protocol is a set of guidelines for exchanging data over a computer network, 
such as local area network, Internet, Intranet, etc. 

Ethernet - Ethernet is the most widely used LAN technology that defines wiring and 
signalling standards for the physical layer of TCP/IP. Ethernet was standardized as 
IEEE 802.3. 

Token Ring - It is a local area network topology where nodes are arranged in a ring 
topology. The data passes between nodes on the network until it returns to the source 
station. A token ring topology uses a token to ensure that only one node on the line is 
used at a time to prevent congestion and collision. The token ring LAN system was 
standardized as IEEE 802.5. 

Fiber distributed data interface (FDDI) - FDDI is an optical data communication 
standard used for long distance networks provides communication with fiber optic 
lines. This protocol is based on the token ring protocol. 

 

A network topology is the arrangement of a network, nodes and connecting lines. The 
physical topology and the logical (or signal) topology are the types of network 
topology. 

Physical Topology 

The physical topology refers to the geometric layout of the connected network. Bus 
Topology, Ring Topology, Tree Topology, Mesh Topology, Star Topology, and Hybrid 
Topology are several forms of Physical Topology. 

 



 

 
Bus Topology 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In the Bus topology system, every computer and network are connected by using a 
single cable. The cable is known as Bus. It transmits the data from one end to another 
end only in a single direction. When it has exactly two endpoints, then it is called 
Linear Bus topology. A network that uses a bus topology is referred to as a bus 
network. Bus networks were the original form of an Ethernet network. 

Ring Topology 

 



 

 
In ring Topology, network nodes are connected in a closed loop configuration. Each 
node has directly connected with its adjacent node on both sides. The Others are 
indirectly connected and the data passing through one or more intermediate nodes. 

�​ Dual Ring Topology - When the transmission is bidirectional by having two 
connections between each network node, it is called Dual Ring Topology. It is a 
network redundant topology where nodes are connected using two concentric 
rings with four branches. If one ring fails, the second ring can act as a backup, 
to keep the network up. 

Tree Topology 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In Tree Topology network, two or more-star networks connected with a root node and 
all other nodes are connected to it forming a hierarchy. It is also called hierarchical 
topology. It should at least have three levels to the hierarchy. This type of topology 
used in Wide Area Network. Tree topology is valued for its scalability and accessibility 
for troubleshooting. 

 



 

 
Star Topology 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In a star topology, all the nodes are connected to a single hub through a cable. This 
hub is the central node. The data can send from one node to another through the hub. 
Hub acts as a repeater for data flow. It can be used with twisted pair, Optical Fibre or 
coaxial cable. 

Mesh Topology 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
In Mesh Topology, every node carries traffic only between the two nodes it connects 
(point-to-point connection). Mesh has n(n-1)/2 physical channels to link n devices. 

 



 

 
Example - Each telephone regional office needs to be connected to every other 
regional office. 

There are two techniques to transmit data over the Mesh topology. They are Routing, 
Flooding. 

✔​ Routing – The nodes have a routing logic to direct the data to reach the 
designation using the shortest distance. 

✔​ Flooding – The data is transmitted to all the nodes in the network, hence no 
routing is required. 

Types of Mesh Topology 

Partial Mesh Topology - In this topology, some of the nodes are connected to all nodes 
and some nodes are connected only to some nodes. 

Full Mesh Topology - Every node is connected to each other. 

Hybrid Topology 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is a group of two or more topologies. It is a scalable topology and it can be 
expanded easily. It is reliable. 

 



 

 
Logical/Signal Topology 

Logical Topology denotes how the signals transmitted from node to node across the 
system. Broadcast and Token Passing are the two types of Logical topology. 

✔​ In Broadcast, there is no need for instructions. Ethernet is working in Broadcast 
transmission. 

✔​ In Token Passing, electronic token is passed to each node. When a token is 
received by the node, the node can send data on the network. Token Ring and 
Fibre Distributed Data Interface (FDDI) are using Token Passing. Arc net is token 
passing on a bus topology. 

 

The Open Systems Interconnection (OSI) Model is an intangible and logical 
arrangement that describes network communication between two systems by using 
different layer protocols. The OSI model developed by the International Standards 
Organization (ISO). It has seven layers to transmit data from one to another. 

 

Physical Layer (Layer 1) 

It is the lowest layer in the OSI model. It deals with the bit-level transmission between 
the devices. It supports mechanical and electrical specifications of the interface and 
transmission medium. Hub, Repeater, Modem, Cables are Physical Layer devices. The 
data unit of this layer is Bit. It converts the signal into 0s and 1s and sends them to 
the next layer. Simplex, half-duplex and full-duplex are the transmission modes for 
this layer. 

Protocols used - ATM, RS232, and Ethernet. 

Data Link Layer 

It is used for the encoding, decoding and logical organization of data bits. It makes the 
physical layer appear error-free. It converts the bits into the frames depending on the 
frame size of Network Interface Card (NIC). Switch and Bridge is Data Link Layer 
devices. HDLC, LSL, and ATM are the implemented protocols on this layer. It has two 
sub-layers. 

�​ Media Access Control (MAC) – It is responsible to the physical address of the 
sender and/or receiver in the header of each frame. CSMA/CD, Ethernet are 
used as protocol. 

�​ Logical Link Control (LLC) – It is responsible for frame management, error 
checking, and flow control of data. 

 



 

 
Network Layer 

This network provides the shortest path for transmitting data for network 
communication to avoid congestion. Data is transmitted in the form of packets 
through the logical network path. The IP address of the sender/receiver is placed in 
the header. Routers are used as networking devices. The IPX and TCP/IP are the 
implemented protocols on this layer. Routing and Logical Addressing are the functions 
of this layer. 

✔​ Routing – Finding the shortest path for data transmission. 

✔​ Logical Addressing – Placing the IP address of the sender/receiver in the header. 
Physical Layer, Data Link Layer, and Network Layer are also known as Hardware Layer. 

Transport Layer 

This layer is called as Heart of OSI model. It is responsible for end-to-end network 
communication, flow control of data, error recovery and reliability and quality of data. 
The data in the transport layer is referred to as Segments. It is operated by the 
Operating System. SPX, TCP/IP’s, DNS are examples of implemented protocols on this 
layer. 

Session Layer 

This layer is responsible for the establishment of the connection, maintenance of 
sessions, synchronization and ensures security. It allows adding checkpoints 
(synchronization points) into the data to identify the error. This layer is the network 
dialog controller which allows two systems into the dialog in either half duplex or full 
duplex mode. RPC, PPTP, SCP, SDP are some protocols of this layer. 

Presentation Layer 

This layer performs encryption and decryption of data. It gives the data in a readable 
format from an application layer perspective. It reduces the number of bits that need 
to be transmitted on the network. It offers liberty from compatibility troubles. It is 
called the Translation layer and Syntax layer. 

Example - ASCII code to EBCDIC coded text file. 

 



 

 
Application Layer 

This layer focuses on process-to-process communication across an IP network and 
provides a firm communication interface and end-user services. It supports services 
such as electronic mail, remote file access, and transfer, shared database 
management, Web chat and surfing, Directory services and Network Virtual Terminal. 
HTTP, FTP, Telnet, SMTP, and DNS have used protocols of this layer. It is also called as 
Desktop Layer. 

Session Layer, Presentation Layer, and Application layer are also known as Upper 
Layers or Software Layers. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

TCP model is a tangible, client-server model. It is one of the most used protocols in 
digital network communications. It has only four layers in a data communication 
network. 

Host-to-Network Layer – In this layer, the host has connected to the network using 
the protocol to send IP packets. Ethernet, Token Ring, FDDI, X.25, Frame Relay are 
used. 

Internet Layer – It transfers the Internet Protocol packets (IP datagrams) to the 
destination. IP, ICMP, ARP, RARP, and IGMP have used protocols. 

Transport Layer – It is like as transport layer in the OSI model. Two end-to-end 
transport protocols are used. Transmission Control Protocol (TCP) and Use Datagram 
Protocol (UDP). 

Application Layer – It contains high-level protocols. TELNET, FTP, SMTP, DNS, HTTP, 
NNTP, DHCP are used. 

 



 

 

 

Data Transmission modes refer to the way of transferring the information or data 
between two connected devices. Three types of transmission modes are: 

✔​ Simplex Mode 

✔​ Half Duplex Mode 

✔​ Full Duplex Mode 

Simplex Mode – In this type, the data can be transferred in only one direction. The 
only one can transmit and the other can receive the data. 

Example – Keyboard (Input) and Monitor (output), Loud Speaker, Television, Fire 
alarm system etc. 

Half Duplex Mode – In this type, the data can be transferred in both directions, but not 
at the same time. Example – Walkie-talkie 

Full Duplex Mode – In this type, the data can be transferred in both direction on the 
same transmission path. Two lines are used for sending and receiving the data. 

Example – Telephone network 
 

Data or information is transferred to one place from another through the 
physical/wireless media which is known as Transmission Media. Guided Media and 
Unguided Media are two types of Transmission Media. 

Guided Media/Bounded Media 

The signals are transmitted through the narrow path which made by physical links. 
Twisted Pair cable, Coaxial Cable and Fibre-Optic Cable are the types of Bounded 
Media. Twisted-pair and coaxial cable accept signals in the form of electric current. 
Optical fibre accepts signals in the form of light. 

Unguided/Unbounded Media 

The signals are transmitted without using any cables. This type of transmission is 
known as wireless communication. Radio waves, Infrared, Micro waves are some 
popular type of unbound transmission media. 

✔​ Microwave – Mobile phone, Satellite networks, Wireless LANs. 

✔​ Radio Wave – Radio, Television and Paging system 

✔​ Infrared – Short range communication (TV remote control, IRD port etc) 

 



 

 

 

Hub - Hub is a networking device which connects multiple network hosts. It is used to 
transfer data. The hub sends data packets (frames) to all devices on a network. Active 
Hub (Repeaters) and Passive Hub are two categories of Hub. 

Switch - Switch is a small hardware device that works at the layer of LAN (Local Area 
Network). It receives incoming data packets, filters the packet and sends only to the 
interface of the intended receiver. It maintains a CAM (Content Addressable Memory) 
table and has own system configuration and memory. CAM table is also known as 
forwarding table or forwarding information base (FIB). 

Modem (Modulator-Demodulator) - It is a hardware component that allows a computer 
to connect to the Internet. It converts analog signal to digital signal. 

Router – It is a hardware device which is responsible for routing traffic from one to 
another network. It is designed to receive, convert and move packets to another 
network. 

Bridge – Bridge is a network device that connects a local area network to another local 
area network that uses the same protocol. 

Gateway - A gateway is a network node that connects two dissimilar networks using 
different protocols together. 

Repeater – It is an electronic device that magnifies the signal it receives. It is 
implemented in computer networks to expand the coverage area of the network. It is 
also known as signal boosters. 

Firewall - A firewall is a network security system that monitors and controls overall 
incoming and outgoing network traffic based on advanced and a defined set of security 
rules. 

 

It is the global computer network providing a variety of information and 
communication facilities, consisting of interconnected networks using standardized 
communication protocols (TCP/ IP). 

ARPANET was the world's first fully operational packet switching computer network, 
developed by the Advanced Research Projects Agency of the U.S. Department of 
Defense in 1969. It connected with only four computers. ARPANET adopted TCP/IP in 
1983 and the “network of networks” became the modern Internet. 

World Wide Web - WWW is one of the services interconnected over the internet. It is a 
collection of all information, resources, pictures, sounds, multimedia on the internet 
which is formatted in HTML and accessed through HTTP. 

Web Server – A web server stores, processes and delivers web pages to the users. 
The intercommunication between users and servers is done using Hypertext Transfer 
Protocol (HTTP). 

Web Page – It is a document was written in HTML that can be accessed through the 
internet by using the web browser. It is identified by Uniform Resource Locator. 

 



 

 
Web Browser - It is a software application that allows users to access the websites. 
Internet Explorer, Google Chrome, Opera, Mozilla Firefox, UC Browser, Apple Safari 
are some examples of a web browser. 

Home Page – Homepage is the default page of the website. 

Hypertext Mark-up Language (HTML) – HTML is used to create web pages that are 
displayed on the Internet. 

Hypertext Transfer Protocol (HTTP) - This protocol is used to transfer data over the 
web. It runs on top of the TCP/IP set of protocols. It uses a server-client model. 

Transmission Control Protocol/Internet Protocol (TCP/IP) – It is a set of 
communication protocols which is used to access the internet. TCP/IP was developed 
by Bob Kahn and Vint Cerf in 1978. 

Internet Host – Host is a computer or application which is used to transfer the data on 
the internet. Each host has a unique IP address called Hostname. 

Internet Protocol Address (IP Address) – It is a logical numeric address that is used to 
identify the host over the internet network. 

✔​ The stable version of IP – IPv4 (32 bits). It is written in decimal and separated 
by periods. 

✔​ Latest Version of IP – IPv6 (128 bits). It is written in Hexadecimal and separated 
by colons. 

Uniform Resource Locator (URL) - A uniform resource locator (URL) is used to locate 
the address of a resource and protocol. 

Domain Name - A domain name serves as an address which is used to access the 
website. It can be universally understood by Web servers and online organizations. 

Top Level Domains are following. 
 

Domain Name Description 
.com Commercial 
.net Network-oriented 
.org Non-Profit Organization 
.edu Education 
.gov Government 
.mil Military 
.int International Treaties 

Domain Name System (DNS) – DNS translates domain names into IP addresses. It has 
a large database of domain names and its IP addresses. 

Uploading – It refers to the transmission of data or files from the computer to the 
internet server. Uploaded file can be retrieved by anyone. 

Downloading – It is the process of copying files from the internet to the user’s 
computer. 

 



 

Email - Electronic mail is the transmission of messages over the internet. In an email, 
the user can attach documents, pictures, videos etc. 

 



 

 
Carbon copy (CC) – It is used to share e-mail with one or more recipients. Both the 
main recipients and other (CC) recipients can see all the mail addresses. 

Blind Carbon Copy (BCC) – In this, the recipients of the message and other recipients 
(BCC) cannot see the persons who all receive the e-mail. 

 

Hacking is an attempt to exploit a computer system or a private network inside a 
computer. It is the unauthorized access to or control over computer network security 
systems for some illicit purpose. Viruses, Keyloggers, Rootkit, Spoofing attack, Packet 
Sniffer, Trojan horse, Password cracking are various of techniques for hacking. 

Computer Virus - A computer virus is a malicious software program loaded onto a 
user’s computer without the user’s knowledge and performs malicious actions. 
Stuxnet, Petya, Wanna cry, Code red, Melissa, Sasser, Zeus, Mydoom, Crypto Locker, 
Flashback are some example of Viruses. 

The Elk Cloner virus was the first self-replicating computer program to spread on a 
large scale. It was created by a 15-year-old Rich Skrenta in 1982. Ryuk, Troldesh are 
ransomware family of newly discovered viruses. 

Computer Worm - A computer worm is a malicious, self-replicating software program 
(malware) which affects the functions of software and hardware programs. Stuxnet is 
the most famous computer worm. 

Ransomware - Ransomware is a type of malware program that infects and takes 
control of a system. It infects a computer with the intention of extorting money from 
its owner. 

Botnet – Botnet is a set of networks connected computers/devices that are used for 
malicious purposes. Each computer in a botnet is called Bot. It is also known as 
Zombie. 

Trojan horse – It is a type of malware that presents itself as legitimate software. It 
may perform actions on a computer that is genuine but will install malware actions. 

Keylogger - A keylogger is a type of malware that stores all keystrokes of a computer. 
It can record all sorts of personal information, such as usernames, passwords, credit 
card numbers, and personal documents such as emails and reports. 

Rootkit - A rootkit is a secret computer program designed to provide continued access 
to a computer while actively hiding its presence. Rootkits are associated with malware 
such as Trojans, worms, viruses. 

Spyware - Spyware is a software that is installed on a computing device without the 
end user's knowledge. It steals internet usage data and sensitive information such as 
usernames and passwords, activating the microphone or camera on a computer to 
record physical activity. 

Adware - Adware is unwanted software designed to display advertisements on the 
computer screen to generate income. This type of ads cannot be removed easily. 

 



 

 
Phishing – Phishing is a cyber-attack that used to steal user data, including login 
credentials and credit card numbers. They use email as a weapon and trick the email 
recipient into believing that the message is received from real companies such as 
banks, Amazon etc to harvest the recipient’s details. Email Phishing, Spear Phishing 
(targets special person/organization) are techniques of Phishing. 

 

 

Abbreviation Full Form 
ASCII American Standard Code For Information Interchange 
ALU Arithmetic Logic Unit 
ALGOL Algorithmic Language 
ARP Address Resolution Protocol 
API Application Program Interface 
ATM Asynchronous Transfer Mode 
AI Artificial intelligence 
BASIC Beginner’s All-purpose Symbolic Instruction Code 
BIOS Basic Input Output System 
Bit Binary Digit 
BCC Blind Carbon Copy 
BIU Bus Interface Unit 
BIS Business Information System 
BPS Bits Per Second 
BCR Bar Code Reader 
BIPS Billion Instruction Per Second 
BRD Blu-Ray Disc 
CAD Computer Aided Design 
CAM Computer Aided Manufacturing 
CADD Computer Aided Design and Drafting 
CAN Campus Area Network 
CC Carbon Copy 
CD Compact Disk 
CDROM Compact Disk Read Only Memory 
CD -R Compact Disk - Recordable 
CD – RW Compact Disk Rewritable 
CD – WO Compact Disk - Write Once 
COBOL Common Business Oriented Language 
CPI Clock / Cycle Per Instruction 
CPU Central Processing Unit 
CRT Cathode Ray Tube 
CASE Computer-Aided Software Engineering 
CPS Characters Per Second. 
CROM Control Read-Only Memory 
DVD Digital Versatile Disk 

 



 

DVI Digital Visual Interface 
DVDR Digital Versatile Disk Recordable 
DVDRW Digital Versatile Disk Rewritable 
DRAM Dynamic Random-Access Memory 
DBMS Data Base Management System 

 

 



 

 

   
DNS Domain Name System 
DHTML Dynamics Hyper Text Mark-up Language 
DPI Dots Per Inch 
DVR Digital Video Recorder 
DOS Disk Operating System 
DTP Desk-Top Publishing 
EDP Electronic Data Processing 
EDSAC Electronic Delay Storage Automatic Calculator 
EEPROM Electronically Erasable Programmable Read Only Memory 
EFS Encrypted File System 
ENIAC Electronics Numerical Integrator And Calculator 
EPROM Erasable Programmable Read Only Memory 
EROM Erasable Read Only Memory 
ESDI Enhanced Small Device Interface 
FORTRAN Formula Translation 
FTP File Transfer Protocol 
FDD Floppy Disk Drive 
FDC Floppy Disk Controller 
FPS Frames Per Second 
FLOPS Floating Point Operations Per Second 
FAT File Allocation Table 
FAX Far Away Xerox/ facsimile 
GDI Graphical Device Interface 
GIF Graphic Interchangeable Format 
GIS Geographic Information System 
GML Geography Mark-up Language 
GPRS General Packet Radio Service 
GUI Graphical User Interface 
GSM Global System for Mobile Communication 
HTTP Hyper Text Transfer Protocol 
HTTPS Hyper Text Transfer Protocol Secure 
HTML Hyper Text Mark-up Language 
HVD Holographic Versatile Disc 
HD Hard Disk 
HDD Hard Disk Drive 
ISP Internet Service Provider 
IP Internet Protocol 
IOP Input Output Processor 
IBM International Business Machines 
IC Integrated Circuit 
ICT Information Communication Technology 
IMAP Internet Message Access Protocol 

 



 

ISO International Standards Organisation 
INTEL Integrated Electronics 
IVR Interactive Voice Response 
JPEG Joint Photographic Expert Group 
JSP Java Server Page 
LAN Local Area Network 
LCD Liquid Crystal Display 

 

 



 

 

    
LED Light Emitting Diode 
LPI Lines Per Inch 
LSI Large Scale Integration 
MAN Metropolitan Area Network 
MIPS Million Instructions Per Second 
MICR Magnetic Ink Character Recognition 
MPEG Motion Picture Experts Group 
MMS Multimedia Message Service 
NAT Network Address Translation 
NIC Network Interface Card 
NTP Network Time Protocol 
OMR Optical Mark Reader 
OSI Open Systems Interconnection 
OSS Open Source Software 
OOP Object Oriented Programming 
OCR Optical Character Recognition 
PAN Personal Area Network 
PDA Personal Digital Assistant 
PDF Portable Document Format 
PHP Hypertext Pre-processor 
PNG Portable Network Graphics 
PPM Pages Per Minute 
PROM Programmable Read Only Memory 
PCB Printed Circuit Board 
PIN Personal Identification Number 
POS Point Of Sale 
PPP Point-to-Point Protocol 
PSTN Public Switched Telephone Network 
POST Power On Self Test 
PING Packet Internet Gopher 
PSU Power Supply Unit 
RAM Random Access Memory 
ROM Read Only Memory 
RIP Routing Information Protocol 
RPM Revolutions Per Minute 
RDMS Relational Data Base Management System 
RARP Reverse Address Resolution Protocol 
SAN Storage Area Network 
SDRAM Synchronous Dynamic Random Access Memory 
SIM Subscriber Identity Module 
SIMM Single In-line Memory Module 
SIU Serial Interface Unit 

 



 

SMPS Switch Mode Power Supply 
SMS Short Message Service 
SMTP Simple Mail Transfer Protocol 
SNAP Sub Network Access Protocol 
SNMP Simple Network Management Protocol 
SQL Structured Query Language 
SRAM Static Random Access Memory 
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TCP Transmission Control Protocol 
TBPS Tera Bytes Per Second 
TIPS Trillion Instruction Per Second 
UNIAC Universal Automatic Computer 
UPS Uninterruptible Power Supply 
URL Uniform Resource Locator 
USB Universal Serial Bus 
ULSI Ultra Large-Scale Integration 
VAN Value Added Network 
VGA Video Graphics Array 
VDU Visual Display Unit 
VIRUS Vital Information Resource Under Seized 
VCD Video Compact Disk 
VGA Video Graphics Array 
VOIP Voice Over Internet Protocol 
VPN Virtual Private Network 
WAN Wide Area Network 
WAP Wireless Application Protocol 
WIFI Wireless fidelity 
WMV Windows Media Video 
WPM Words Per Minute 
WORM Write Once Read Many 
XML Extensible Mark-up Language 
XMF Extensible Music File 
XHTML Extensible Hyper Text Mark-up Language 
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